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1 Introduction

Ever watch a movie where you couldn’t help but exclaim ”No way! That could never really
happen”? Perhaps you don’t buy the lone gunman theory and are just itching to analyze the
Zapruder film. Either way, you have taken the first step towards a line of questioning that if
followed carefully could easily count as ”doing science.” Today with the aid of digital media tools,
we can take that movie–stop it, turn it around, interrogate it for data. Using what we have learned
from the physical sciences, we can frame and answer questions about the movement of bodies and
the forces required for these motions. Most of what we need to answer these questions is right there
on the screen. We just need to stop and look. In this project that’s what students do, except instead
of just gathering data and finding their answers, they go on to share their findings, to present their
conclusions along with the original footage in a manner aptly suited for the generations raised on
MTV.

Science, more than simply a body of knowledge, is a dynamic self-correcting process that seeks
to understand and explain the world in which we live. It is a process with rich intrinsic rewards,
and at its height it requires of us a great deal of rigorous thought, questioning, hard work, risk
taking, and yes–creativity. Too often the full breadth of these facts is obscured by the traditional
restraints placed upon instructors and students. It doesn’t have to be that way. This project tries
to get at the process of science while allowing as much freedom for students as possible.

2 Project Description

Students, working individually or in small groups, take ANY piece of video footage, real world
or fictional (e.g., CNN or Hollywood), and add to it their own analysis of the physics presented–
answering questions sparked by their viewing. The students interrogate the video for data, develop
a method for arriving at solutions to their questions, and repackage the original footage into a final
product that serves to communicate their findings. Final products consist of the original footage
overlaid with any combination of narration and pictorial commentary, including student-produced
animations and visualizations of abstract concepts.

For example, a group might choose to examine a clip from an action film in which a character
is hit with such a force that he flys backwards, hitting the wall before sliding to the ground. They
might then calculate how fast the character would have to be flying through the air for this to
happen. They could find the actor’s weight via the internet (oddly you can find many actors’
weights in this way) and calculate the force necessary to produce the needed acceleration. They
would then put together a collection of overlays and illustrations to help communicate their findings
and integrate them with the original clip to produce their project.

1Web: <www.phylm.org>
2Web: <http://www.davidcolarusso.com> E-mail: <colarusso@post.harvard.edu>
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3 Project Steps

Students should work individually or in small groups of no more than three.

1. Show students an example of a project that you have created. This is very important as many
students have a hard time visualizing such a project.

2. Provide suggestions for topics, and discuss as a class what types of questions they are equipped
to answer.

3. Have your students choose a clip to examine. They should have some tentative question(s) in
mind (e.g., is this event possible, or how much force would such an event require, etc.). Make
sure that they will be able to measure or find through research enough data about the system
in order to answer their tentative questions. Their questions should be explicit. Encourage
them to keep it simple.

4. Have students create their own folder and iMovie project. The project should be created in
the new folder, and then they should import their clip into iMovie. To import VHS or DVD
clips, run the output from a VCR or DVD player through an Analog to Digital Converter.
This allows you to import via Firewire straight into iMovie. Newer video tapes and DVDs
are now making use of blocking technology to prevent copying. This may prevent you from
say, copying a clip onto MiniDV then importing it with iMovie. However, if you are using
the clip in accordance with ”fair use,” you have a legal right to import the material, source:
<http://www.techlearning.com/db area/archives/TL/2002/10/copyright answers.html>

5. Direct students to print out any frames from which they may be able to gather data (i.e.,
measure apparent distances, etc.). This can be done in iMovie by having them pause on the
desired frame and then choose ”File>Save Frame As....” Here they may save the frame as an
image which they can then open and print out.

6. Have students take measurements of objects in their system with a ruler, pencil, and protractor–
measuring directly off of the printout. Be sure to have them take into account perspective.
They will need to make assumptions about objects and devise ways to relate the lengths and
positions of objects they know to those they do not. Make sure they understand that they
will have to make estimates. Discuss how they might choose to do this and what it means
for any of their conclusions. Also make use of iMovie to measure the time between events.
Simply have the students take note of the differences between the times of events as shown by
the displayed time, remembering that it reads out in minutes:seconds:frames and that each
frame is 1/30 of a second. Also remind them that sometimes movies do not use real time.

7. After they have gathered information about their clip, have students explicitly list out what
they do and do not know, and then have them attempt to solve for what they would like to
know. If they do not have enough information to solve/answer their question(s), they may
have to further interrogate their clip or increase their number of assumptions.

8. Having answered their questions about the systems, students should think about any surprises
they ran into. Was something more or less plausible than they thought? If so, are they sure
they have done their calculations correctly? What about their assumptions? Could they be
wrong? By how much? What would that do to their answer(s)?
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9. Now your students need to carefully plan out what they would like their final clip to look
like. How would they like to share what they have learned? Where will they need visuals?
Do they need to slow the clip down at any point or ”pause” it? Would they like to replay a
part of the clip multiple times? Have them produce two storyboards. Their first storyboard
should be of the clip as it stands. Have them draw a ”comic strip” of the scene, making a
new cell every time the camera angle changes or there is a significant change in the image
composition. These will serve as portable versions of their clips that they can take away from
the classroom. Their second storyboard should depict their vision for their final product.
This one can be worked on away from the computer, using the first storyboard as a reference.
Remind them of what they can do: reorder clips; reverse playback direction; slow things
down; speed things up; create still frames, overlay narration, etc.

10. After they have completed their storyboards, have them begin work on editing their base clip.
This is the video they have already imported. They need to cut off any excess from the ends,
reorder, and edit any feature they need to now. Once they begin working on their overlays,
they will not be able to edit their base clip.

11. After they have edited their clips, have them choose ”File>Export...” then choose ”Export:>To
QuickTime” from the pulldown menu, then choose ”Formats:>Expert Settings” from the pull-
down menu. They should then click ”export. A new window will appear. Have them choose
”Export>Movie to QuickTime Movie” from the pulldown menu and ”Use:Default” from the
pulldown menu. By clicking on ”Options, they may choose the ”Compression Settings. What’s
important is that the setting they choose allow them to ”link to the file from Flash. ”Video
is a safe choice. Students should then save the file in their own directory with some name
they will remember. Have them then open and play the file they just saved to make sure it’s
what they wanted. If necessary they may tweak their iMovie project and export again to get
the desired results.

12. They should open Macromedia Flash MX and make the following changes to the Document
settings. They can do this by choosing ”Modify>Document... then setting the values as
follows: Dimensions: 720px (width) X 480 px (height); Background color = black; Frame
Rate: 29.97; Ruler Units: Pixels.

13. Have them choose ”FiIe>Import...” and import the QuickTime movie they created with
iMovie. They should be prompted to either ”embed the video or ”link to external video file.
They should choose to ”link. They will then be informed that the video requires some number
of frames to display its entire length. Have them choose ”yes” to automatically inserting the
required number of frames.

14. The clip should now appear in the flash project. They will not be able to hear the clip. Have
them create new layers above the one containing their clip. Here students may begin adding
overlays. Be sure to have them periodically save their projects in their folders.

15. Have your students add the commentary they have worked out in their storyboards. They
may need to refer to the lessons and tutorials available under Flash’s ”Help menu item for
assistance.

16. After they have completed their overlays, have them return to the beginning of their projects.
Have them create a single frame in a new layer where they should write a short introduction
to their piece. Be sure to have them cite the makers of the base clip, giving proper credit.
They should include the source film’s name, the production house, and the year of release.
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17. They are now ready to export their projects. Have them Choose ”File>Export Movie...”
Have the students create a new folder named ”final” inside their own folder then save the
movie inside this folder. Make sure the Format is ”QuickTime and that the QuickTime
settings are as follows: Dimensions 720 X 480 (”checked” Match Movie); Alpha: Auto; Layer
Auto; Controller: Standard; Playback: Paused At Start; File: Flatten (”checked” Make
self-contained).

18. Students should view their QuickTime file, making sure it has come out as they expected. If
necessary they may tweak their Flash file and export again to get the desired results.

19. If the equipment is available and students wish to, they may burn their files to CD or DVD
so that they can take their projects with them. This serves as an excellent tangible product
that students can look back on after the class.

20. Students should also produce a short write-up on how they made their project including all
of their measurements, assumptions, and calculations as they most likely will not share all of
these on-screen.

4 Outcomes

After completing this project, students will be able to:

• Analyze video clips for physical quantities (e.g., speed, velocity, time, etc.) and estimate their
values.

• Use research to make reasonable assumptions about quantities that cannot be directly ob-
served.

• Frame questions about physical systems that may be answered using the students’ own knowl-
edge of physical laws.

• Calculate approximate values for remaining unknowns based upon their assumptions (i.e.,
answer their own questions about the system).

• Communicate their assumptions and conclusions about a physical system to an audience of
their peers.

5 Technology Skills

After completing this project, students will be able to:

• Import, manipulate, edit, and export digital video using iMovie.

• Create simple Macromedia Flash animations and stills.

• Integrate Flash and exported iMovie clips (in QuickTime format) into one stand-alone video
clip.

• Sync audio overlays using iMovie for export to QuickTime or MiniDV.
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6 Assessment Suggestions

You may choose to further involve the class by evaluating students from a class-developed rubric,
based upon items such as production quality, scientific correctness and so forth.

7 Preparation and Duration

This project works well as an end of the term project, tying together previously covered topics.
Depending upon the amount of student outside work (e.g., planning and storyboarding), the unit
should take about one to two weeks of in-class work.

The time saved through systematic pre-planning on the part of students cannot be over em-
phasized. Before exporting their iMovie project to QuickTime for integration with a Flash track,
students should very thoughtfully plan what their final product will look like and edit their clip
accordingly. Students should make use of storyboarding outside of class so that their in-class
time with technology does not have to compete with project decisions that could have been made
beforehand.

8 Tools and Resources

• Video Clip: VHS, DVD, MiniDV, QuickTime, or DV Stream

• Hardware: Macintosh computers. For VHS and DVD clips only: Playback device and analog
to digital converter (RCA or S-Video to Firewire)

• Software: iMovie. Macromedia Flash MX

• Internet: <http://www.phylm.org> A step-by-step on-line tutorial for instructors and stu-
dents, including animations, technical tips, and mockup project examples.

• Internet search engine such as: <http://www.google.com>

• Copyright information and guidelines:
The Educator’s Guide to Copyright and Fair Use
<http://www.techlearning.com/db area/archives/TL/2002/10/copyright.html>
Copyright 101 for Educators
<http://www.techlearning.com/db area/archives/WCE/archives/copywes.html>

9 Prerequisite Skills

Students must have a good deal of familiarity with physical laws and problem solving in order to
frame and answer questions about the systems in their video clips. A good coverage of mechanics
is strongly suggested.

10 Facilitation Tips

You may wish to prep students by including questions about movie scenarios in tests prior to this
project. For example, you may ask a question about what would ”actually” happen if the car in a
movie tried to jump the canyon assuming a D meter wide gap, a speed of V m/s, and an incline of
only X degrees. Additionally, encourage students to use each other as resources for tech help.
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Additionally, modeling a completed project is very important, as many students have a hard
time visualizing what their finished product is supposed to look like. I suggest that instructors first
construct their own brief project to communicate this and to become familiar with the technical
aspects of the process. I would place examples of student projects on the phylm website except
currently there is no easy way for me to legally share such content over the internet as none of my
students have made use of base clips that are in the public domain. I will, however, place a mockup
clip there for viewing.

11 Technology Tips

When exporting from Flash to QuickTime, it is important to have the ”Publish Settings” for
Flash set to ”Flash Player 5,” as QuickTime does not yet recognize the Flash 6 format. Failing
to do this will result in the error message ”The installed version of QuickTime does not have a
handler for this type of Macromedia Flash movie....”

More technical tips are available at: <http://www.phylm.org>
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